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4 EB 5724 EN

Safety instructions

General safety instructions

� Assembly, start-up and operation of this device may only be performed by
trained and experienced personnel familiar with the product.
According to these mounting and operating instructions, trained personnel
refers to individuals who are able to judge the work they are assigned to
and recognize possible hazards due to their specialized training, their
knowledge and experience as well as their knowledge of the applicable
standards.

� Any hazards which could be caused in the connected valve by the process
medium, operating pressure or moving parts are to be prevented by means
of the appropriate measures.

� Proper shipping and appropriate storage of the device are assumed.

� The electric actuators have been designed for use in electrical power
installations. For wiring and maintenance, you are required to observe the
relevant safety regulations. Only use power interruption devices which are
protected against unintentional reconnection of the power supply.

� Note:
Actuators with a CE marking fulfill the requirements of the Directives
94/9/EC and 89/336/EEC.
The Declaration of Conformity is available on request.



1 Design and principle of
operation

The Type 5724/5725 Controller with Elec-
tric Actuators consist of an actuator and a
digital controller integrated into the housing.
They are especially designed for domestic
hot water heating in instantaneous heating
systems in small to medium-sized buildings
and for fixed set point control circuits in me-
chanical engineering applications.
They are particularly suitable for mounting
to SAMSON Types 3213, 3214, 3260,
3222 and 3226 Valves. Special versions of
Types 3222 (DN 15) and 3222 N (DN 15)
Valves with a specially designed plug can
be used for small buildings (apartments or
single-family dwellings). They ensure that
even small amounts of tapped hot water can
be regulated properly.
The input of the integrated digital controller
is connected to a temperature sensor which
can optionally be upgraded by a flow rate

sensor or flow switch.
In mechanical engineering applications, an
mA signal can alternatively be used.
The set point of the controller is set at 60 °C
and can be manually changed at the set
point potentiometer (11) or over the
TROVIS-VIEW Operator Interface.
The electric actuator consists of a reversible
synchronous motor and maintenance-free
gearing.
A coupling nut (4) provides a force-locking
connection between the actuator and the
plug stem of the valve. For form-fit attach-
ment, a stem connector is used.

Type 5724 without safety function
The force of the electric motor is transmitted
via gearing and crank disk to the actuator
stem (3) and to the plug stem of the mounted
valve. The motor is switched off by
torque-dependent switches when an end po-
sition is reached or in case the motor is
overloaded.

EB 5724 EN 5

Design and principle of operation

Fig. 2 · Type 5724/5725 Controller with Electric Actuator (front cover open), with force-locking attachment to valve

1 Controller with actuator
1.1 Front cover
1.2 Cable entry
2 Handwheel

(Type 5724 only)
3 Actuator stem
4 Coupling nut
8 Spring assembly

(Type 5725 only)
9 Scale for travel indication

11 Set point potentiometer
12 Serial interface

(RJ-12 jack)
Caution!
Do not open the back housing cover!



When the actuator stem retracts in actuators
with force-locking connection, the plug stem
follows the movement of the spring installed
in the valve, causing it to retract.
The valve can be manually moved to the re-
quired position with the handwheel (2).

Type 5725 with safety function
The controller with electric actuator with
safety function is basically the same as Type
5724. However, it contains a spring assem-
bly (8) and an electromagnet. When the
control voltage at the electromagnet is inter-
rupted, the actuator moves to fail-safe posi-
tion because the electromagnet voltage
drops, causing the coupling between gear
and actuator motor to be disengaged. The
actuator stem is completely moved in the di-
rection OUT by the spring mechanism. A
mounted globe valve is closed (fail-safe po-
sition).

Caution!
Do not use the magnet for control tasks.

In Type 5725, there is no handwheel (2) on
the housing cover. Manual override is possi-
ble, after removing the front cover, using a
4 mm hex screwdriver (section 4.1.2).

Typetesting
Type 5725 Controller with Electric Actuator
is typetested in the force-locking version to-
gether with various SAMSON valves by the
German Technical Inspectorate (TÜV) ac-
cording to DIN 32730.
The register number is written on the
nameplate.

1.1 Accessories

Communication (refer to section 8)

� TROVIS-VIEW Configuration and Opera-
tor Interface (6661-1060) for Type 5724
and Type 5725 Controller with Electric
Actuator

� Hardware package
Accessories for direct and indirect data
transmission (including a memory pen,
connecting cable and modular adapter),
order no. 1400-7704

� Memory pen
Indirect data transmission,
order no. 1400-7697

DHW in instantaneous heating system

� Type 5207-0060 Temperature Sensor,
optimized Pt 1000 temperature sensor
with fast response time and easy to in-
stall

� Sensor pocket
for Type 5207-0060 Pt 1000 Sensor to
mount it at the heat exchanger with G ¾
thread in the best position for DHW
heating in instantaneous heating system
(order no. 1400-9249)

� Flow rate sensor,
Axial turbine flowmeter for liquids with
extension cable and mating connector
(order no. 1400-9246)

� Flow switch
for recognizing when hot water is being
tapped (order no. 1400-9247)
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1.2 Technical data
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Design and principle of operation

Controller with Electric
Actuator

Type 5724 5725

-10 -13 -20 -23 -30 -33 -10 -13 -20 -23 -30 -33

Safety function Without With

Connection to valve Force-locking Form-fit Force-locking Form-fit

Rated travel mm 6 6 12 12 15 15 6 6 12 12 15 15

Transit time for rated travel s 35 18 70 35 90 45 35 18 70 35 90 45

Transit time in case of
fail-safe action

s
– 4 6 7

Fail-safe action – Stem extends

Nominal thrust N 700 500 280

Power supply 230 V (±10 %), 50 Hz 230 V (±10 %), 50 Hz

Power consumption, approx. VA 3 7 3 7 3 7 5 9 5 9 5 9

Manual override Yes Possible 1)

Permissible ambient temperature 0 to   50 °C 0 to   50 °C

Permissible storage temperature –20 to   70 °C –20 to   70 °C

Perm. temperature at connecting stem 0 to130 °C 0 to 130 °C

Degree of protection (upright
position) IP 54 IP 54

Noise immunity EN 61000-6-2 EN 61000-6-2

Noise emission EN 61000-6-3 EN 61000-6-3

Weight, approx. 1.1 kg 1.3 kg

Additional electrical equipment

Temperature sensor Pt 1000

Flow rate sensor 530 pulses/l, measuring range 1 to 30 l/min

Flow switch 2) Yes · Alternative to flow rate sensor

Binary input BE1 Floating contact to switch between internal set points or to
deactivate the function to keep DHW temperature constant

Binary input BE2 Flow switch

Binary output 230 V/50 Hz, max. 1 A

1) Manual override using a 4 mm hex screwdriver (after removing the housing cover),
always returns to fail-safe position after safety release.

2) The flow switch or flow rate sensor is not required in DHW heating in instantaneous systems with a
constant circulation.



2 Attachment to valve

Depending on the version of the valve, the
actuator is connected to the valve either over
a force-locking connection or over a form-fit
connection using as a stem connector.

2.1 Type 5724

2.1.1 Force-locking attachment

1. Retract the actuator stem (3) by turning
the handwheel (2) counterclockwise.

2. Position the actuator on the valve con-
nection and tighten coupling nut (4) with
a tightening torque of 20 Nm.

2.1.2 Form-fit attachment

1. Place actuator on the rod-type yoke (15)
and tighten the coupling nut (4) with a
tightening torque of 20 Nm.

2. Place actuator with yoke (15) on the
valve and tighten the nut (17) with a
minimum tightening torque of 150 Nm.

3. Pull plug stem until it reaches the actua-
tor stem or extend actuator stem using
the handwheel (2).

4. Position the clamps of the stem connector
(16) included in the accessories on the
ends of the actuator stem and plug stem
and fasten tight.

Fig. 3 · Attaching actuator and valve

8 EB 5724 EN

Attachment to valve

2 Handwheel (Type 5724 only)
3 Actuator stem
4 Coupling nut

15 Rod-type yoke
16 Stem connector
17 Nut

Force-locking attachment with a coupling nut,
e.g. on Type 3222 Valve

Form-fit attachment with stem connector,
e.g. with rod-type yoke on Series V2001 Valve



2.2 Type 5725

2.2.1 Force-locking attachment

1. Unfasten front cover and place a 4 mm
hex screwdriver on the red actuating
shaft.

2. Turn screwdriver counterclockwise only
and only up to the final travel value at
the point where the torque switch is acti-
vated (switching off the synchronous mo-
tor).

Caution!
Turning the actuator too far will destroy
it.

3. Hold the screwdriver in place and fasten
valve and actuator together using the
coupling nut (tightening torque 20 Nm).

4. Remove screwdriver and carefully screw
back on the front cover.

2.2.2 Form-fit attachment

Proceed as described in section 2.1.2.

2.3 Mounting position

The control valve must be mounted in the
pipeline with the actuator on top to achieve
the stated degree of protection.

2.4 Travel indicator scale

The travel indicator scale has two opposed
scales for adaptation to different valve ver-
sions. Which scale should be used depends
on the valve version (Fig. 4):

Globe and three-way diverting valves

The driving pin is in position 0 (delivered
state).

Three-way mixing valves

Remove scale, turn it and replace it so that
the pin is positioned over the appropriate
hole (6, 12 or 15) corresponding to the
rated travel (6 mm, 12 mm or 15 mm
travel).

EB 5724 EN 9

Attachment to valve

Fig. 4 · Scale for travel indication

Holes for driving pin with
three-way mixing
valve

Driving pin in position 0,
location of scale with globe or three-way
diverting valves (standard)



3 Electrical connection

For installation of the electric cables,
you are required to observe the re-
gulations for electrical power sys-
tems according to DIN VDE 0100 as
well as the regulations of your local
power supplier.
Use a suitable power supply which
guarantees that no dangerous volta-
ges from the system or parts of the
system reach the device in standard
operation or in the event of a fault.

Caution!
Only connect the device to the main
power network when the power is
switched off. Make sure the power
cannot be switched on unintentional-
ly!

The controller with electric actuator requires
a Pt 1000 temperature sensor to be con-
nected for it to function.

Two set points W1 and W2 can be used for
DHW temperature control. The binary input
BE1 is used to switch between the set points.

Additionally, a flow rate sensor or a flow
switch can be connected to quickly recog-
nize when hot water is being tapped.

Alternatively, a 0(4) to 20 mA current input
can be used instead of the Pt 1000 sensor
for control in mechanical engineering appli-
cations.

The connected temperature sensor and the
current input configured as 4 to 20 mA are
monitored for line breakages.
A fault in the line of a sensor is indicated by
the red LED blinking slowly.

Note!
Line breakages cannot be detected when a
0 to 20 mA signal is used.

� Perform the electrical wiring as required
by the application according to one of
the following wiring diagrams (Fig. 5).
As soon as the actuator is connected to
the power supply, the initialization pro-
cedure starts:
The actuator stem extends (with direction
of action increasing/increasing) and the
red and yellow LEDs located underneath
the serial interface light up.
As soon as the actuator stem has
reached the final position, the red LED is
turned off. The yellow LED remains illu-
minated and indicates that the controller
with electric actuator is ready for opera-
tion.
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Electrical connection

Fig. 5 · Electrical connections

LL1 N 5V INS1 S1S2

230V, 50Hz
3)

4)

Operation with Pt 1000 sensor

DHW heating in instantaneous heating system

1)

LL1 N 5V INS1 S1S2

230V, 50Hz
3)

4)

Operation with Pt 1000 sensor
and flow rate sensor

(refer to Fig. 6 on the connection of a flow rate sensor)

BE1

LL1 N 5V INS1 S1S2

230V, 50Hz
3)

4)

Operation with Pt 1000 sensor and
binary contact for switching between set points

BE22)

4)

LL1 N 5V INS1 S1S2

230V, 50Hz
3)

Operation with Pt 1000 sensor and
flow switch

LL1 N 5V INS1 S1S2

230V, 50Hz

+ –4(0) ... 20mA

3)

4)

Mechanical engineering applications

Operation with Pt 1000 sensor and
external set point over an mA signal input

LL1 N 5V INS1 S1S2

230V, 50Hz

+ –4(0) ... 20mA

3)

4)

Operation with mA sensor input

1) Flow rate sensor
2) Flow switch

3) Pump control or fault alarm output
4) Electromagnet, for Type 5725 only
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Electrical connection

18.9

20

150

bl Jack

gn

wh

Nameplate Cable tie

Plug connector

Wire end ferrule

br

gn wh

br
gn
wh

50 mm

PVC 3 x 0.5 mm²

approx.Ø125

Fig. 6 · Connection of flow rate sensor

* Connection of the flow rate sensor (WSS)

Flow rate sensor
with extension cable,
order no. 1400-9246

Controller with electric
actuator

WSS Extension cable Type 5724/25

GND
Signal
5 V

– bl ––––– br –––––
– gn ––––– gn –––––
– wh –––– wh –––––

–––––
––––– IN
––––– 5V

br brown
gn green
bl black
wh white



4 Manual operation without
TROVIS-VIEW

4.1 Changing the travel position

Direction of action and travel can be read
off the travel indication scale (Fig. 7).

4.1.1 Type 5724

Use the handwheel to adjust the travel
(Fig. 7):

� Turn clockwise ⇒ Actuator stem extends
(approx. 4 turns for 1 mm travel)

� Turn counterclockwise ⇒ Actuator stem
retracts (approx. 4 turns for 1 mm travel)

4.1.2 Type 5725

Caution!
The actuator is live.

1. Unfasten front cover and place a 4 mm
hex screwdriver on the red actuating
shaft.

2. Turn the screwdriver clockwise only, and
only up to the final travel value at the
point where the torque switch is acti-
vated (switching off the synchronous mo-
tor).

Caution!
Turning the actuator too far will destroy
it.

After the safety release of the magnet,
the actuator cannot hold the position.
The spring assembly pushes the actuator
stem back into the fail-safe position (ac-
tuator stem extends).

4. Remove screwdriver and carefully screw
back on the front cover.
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Fig. 7 · Type 5724 Controller with Electric Actuator

Travel indication scale

Handwheel



4.2 Changing set point W1

The default setting of the set point W1 is
60 °C and set point W2 70 °C.
These set point can be altered in the
TROVIS-VIEW interface.

To manually adjust the W1 set point without
TROVIS-VIEW, turn the set point potentiom-
eter (11 in Fig. 2) located on the board of
the actuator. The adjustable setting range is
between 10 and 100 % of the measuring
range (default: lower measuring range
value Xmin = 0 °C and upper measuring
range value Xmax = 100 °C).
In the delivered state, the set point potenti-
ometer is set to 0 %, i.e. it does not have
any effect on W1 set point (60 °C).

Note:
– The set point potentiometer only takes ef-

fect when the actual value originates
from a Pt 1000 sensor. In the combina-
tion with F05 - 1 (Current input active)
and F06 - 1 (Current input function = set
point), the set point potentiometer is not
active.

– The manually adjusted value at the set
point potentiometer for W1 is only used
for control if function block F12 in
TROVIS-VIEW is set to 1 (Set point po-
tentiometer automatic: Manual setting ef-
fective, if above 10 %) , see section
6.10. The required setting F12 - 1 is the
default setting.

– The W2 set point can only be changed
in TROVIS-VIEW.

1. Unfasten front cover.

2. Set W1 set point as required at the set
point potentiometer (11 in Fig. 2).

Setting range: 0 to 100 % of the measur-
ing range (default setting 0 to 100 °C)
Do not forget to check the set point po-
tentiometer automatic function.

3. Carefully refasten the front cover.

Set point potentiometer automatic function

� Any setting below 10 % at the set point
potentiometer is ignored by the control-
ler. The controller uses the W1 set point
from the parameter list (TROVIS-VIEW
interface) for control.

� Any setting above 10 % at the set point
potentiometer is used by the controller
for control. The W1 set point entered in
TROVIS-VIEW is ignored.

14 EB 5724 EN
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5 Dimensions in mm
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Dimensions in mm

Types 5724-13/-23
Types 5725-13/-23

eL Stem retracts

aL Stem extends

46
.5

Ø10

146

82
11

3

12

18
Ø

70

48

51

44
(33) 103

136

40
Types 5724-33
Types 5725-33

eL Stem retracts

aL Stem extends

Types 5724-10/-20
Types 5725-10/-20

eL Stem retracts

aL Stem extends
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Dimensions in mm

Ø3.3

Ø5.4

10
.5

15
52

 ±
1

20
00

ap
pr

ox
.

50

Type 5207-0060 Temperature
Sensor (Pt 1000)

Response times: t0.5 < 1 s,
t0,9 < 3 s; in water 0.4 m/s

PN 16
max. medium temperature: 80 °C

Flow rate sensor with
extension cable

(order no. 1400-9246)
Measuring range: 1 to 30 l/min,

DN 10, PN 10, IP 54
max. medium temperature: 70 °C

2 m extension cable

146

82
11

3
46

.5

48
Ø10

40Types 5724-30
Types 5725-30

eL Stem retracts

aL Stem extends

Accessories for domestic hot water
heating:

Flow switch
(order no. 1400-9247)

Switching point: 2.5 ± 0.5 l/min
increasing/closing

Horizontal mounting position!
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Dimensions in mm

Sensor pocket (incl. gasket)
for heat exchanger with G ¾

(order no. 1400-9249)

Sensor pocket (incl. gasket)
for heat exchanger with G 1

(order no. 1400-9252)

Connecting piece (incl. gasket)
for valve G 1

(order no. 1400-9237)

Connecting piece (incl. gasket)
for valve G ¾

(order no. 1400-9236)

Circulation circuit
connection (incl. gasket)
(order no. 1400-9232)



6 Functions

Functions and parameters are entered in the TROVIS-VIEW Operator Interface (see
section 7).

6.1 Domestic hot water heating in instantaneous heating system

In DHW heating in instantaneous heating systems, the hot water temperature is regulated to
the selected set point:

� When the DHW temperature drops below the Set point, the actuator opens the valve to
increase the DHW temperature.

� When the DHW temperature exceeds the Set point, the actuator closes the valve to
reduce the DHW temperature.

Function WE Configuration

F01 – Hot water tapping recognition 1 F01 - 0

Parameter WE Range of values

P01 – W1 set point 60 °C 0 to 100 °C

P02 – W2 set point 70 °C 0 to 100 °C
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Fig. 8 · DHW heating in instantaneous heating system with flow sensor and hot water tapping recognition
(flow rate sensor WSS)

Hot water (WW)

Circulation (Zir)

Cold water (KW)

VSTW DHW flow sensor
WSS Flow rate sensor

RL District heating return pipe
VL District heating supply pipe



Application with DHW flow sensor

A Pt 1000 temperature sensor (e.g. Type 5207-0060, ideally in combination with a sensor
pocket to optimally position the sensor at the heat exchanger) measures the DHW tempera-
ture at the heat exchanger. The measured temperature is compared to the set point and the
valve is open/closed to achieve the set point temperature (as described previously).

Application with current input

The actual flow temperature can also be input over the current input (0 to 20 mA or 4 to
20 mA) instead of the flow sensor. The input signal is based on the measuring range (Xmin
to Xmax). The measured DHW temperature (actual temperature) is compared to the set point
and the valve is open/closed to achieve the set point temperature (as described previously).

Note!
The function to keep the hot water temperature constant (see section 6.3) is not possible with
an active current input.

Functions WE Configuration

F05 – Current input 0 F05 - 1

F06 – Current input function 0 F06 - 0

F07 – Measuring range of current input 0 F07 - 0: 0 to 20 mA
F07 - 1: 4 to 20 mA

Parameters WE Range of values

P03 – Lower measuring range value Xmin 0 °C 0 to   60 °C

P04 – Upper measuring range value Xmax 100 °C 95 to 150 °C

6.1.1 Hot water tapping recognition with flow switch

The flow switch registers the start and end of hot water tapping. When the contact is closed,
the pump starts to run; the DHW temperature control at the DHW flow sensor is active.
When the contact is open, the valve closes and the pump is switched off.

Functions WE Configuration

F01 – Hot water tapping recognition 1 F01 - 1

F02 – Flow sensor 1 F02 - 0
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6.1.2 Hot water tapping recognition with flow rate sensor

In contrast to the hot water tapping recognition with flow switch, the flow rate sensor regis-
ters the extent of the tapping as well as the start and end of the hot water tapping.

By activating the Adaptation function, the controller with electric actuator adapts itself auto-
matically to the changing network conditions without having to change the control parame-
ters (see section 6.6). The optimization function can only be activated when a flow rate sen-
sor is used.

Functions WE Configuration

F01 – Hot water tapping recognition 1 F01 - 1

F02 – Flow sensor 1 F02 - 1

F03 – Adaptation 1 F03 - 1

6.2 Switching between set points

The controller with actuator can use two different set points W1 and W2 for control, e.g. to
regulate the hot water temperature for normal use and the hot water temperature for thermal
disinfection. The change between the set points is made over the binary input (BE1):

� BE1 open: W1 set point active
� BE1 closed: W2 set point active

The option to change between W1 and W2 set points only exists when the DHW tempera-
ture is measured with a Pt 1000 sensor (F05 - 0).

Note!
The current input cannot be used when the binary input BE1 is used.
The termination of the function to keep the DHW temperature constant (see section 6.3) is
likewise not possible when the binary input is already used for switching between set points.

Functions WE Configuration

F05 – Current input 0 F05 - 0

F08 – Function (binary input) 0 F08 - 1
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6.3 DHW temperature in heat exchanger kept constant

When the hot water tapping recognition function is active, the actuator only controls the
DHW temperature to the set point when there is a demand for hot water. The function to
keep the DHW temperature in the heat exchanger constant prevents the water temperature
in the heat exchanger from dropping to ensure that the water temperature reaches the re-
quired set point W1 quickly when there is a new demand for hot water. This is achieved by
keeping the temperature reduced by the Set-back difference in between hot water tappings.
Depending on the configuration, the reduced set point applies after hot water has been
tapped until the next demand or until the time entered in Heating period for exchanger (P12)
has elapsed.

Note!
An active DHW temperature in the heat exchanger kept constant function stops after a
power supply failure has occurred.
After the power supply has been reconnected, hot water needs to be tapped to reactivate the
function.

Functions WE Configuration

F01 – Hot water tapping recognition 1 F01 - 1

F09 – DHW temperature in heat
exchanger constant

0 F09 - 0: Time period adjustable (P12)
F09 - 1: Continuous

Parameters WE Range of values

P11 – Set-back difference 8 K 0 to 30 K

P12 – Heating period for exchanger 24 h 0 to 48 h

Effect of binary input BE1

If the binary input BE1 is not needed to switch between set points, it can be used to terminate
the function to keep DHW temperature in the heat exchanger constant.

� BE1 open: DHW temperature in the heat exchanger kept constant function
after configuring function block F09.

� BE1 closed: Function inactive.
An active function to keep DHW temperature in the heat exchanger
constant is terminated immediately when the contact of binary input
BE1 is closed, even when the time entered in Heating period for
exchanger has not yet elapsed.
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Note!
The current input cannot be used when the binary input BE1 is used.

Functions WE Configuration

F05 – Current input 0 F05 - 0

F08 – Binary input function 0 F08 - 0

6.4 Excess temperature protection

The actuator closes the valve when the flow temperature measured at the flow sensor exceeds
the Upper limit GWH.

The function block setting F10 - 0 means that the upper limit of the flow temperature is not
monitored.

Function WE Configuration

F10 – Upper limit GWH 0 F10 - 1

Parameter WE Range of values

P05 – Upper limit GWH 95 °C 0 to 100 °C

6.5 Frost protection

The lower limit of the flow temperature is monitored when this function is active. When the
temperature falls below Lower limit GWL, the actuator opens the valve until the temperature
exceeds the lower limit plus hysteresis.

The function block setting F11 - 0 means that the lower limit of the flow temperature is not
monitored.

Function WE Configuration

F11 – Lower limit GWL 0 F11 - 1

Parameter WE Range of values

P06 – Lower limit GWL 5 °C 0 to 20 °C
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6.6 Control parameters

Parameters WE Range of values

P07 – Proportional gain KP 0.6 0.1 to 50

P08 – Reset time Tn 25 s 0 to 999 s

P09 – Derivative-action time Tv 0 s 0 to 999 s

P10 – Actuator transit time Ty 35 s 0 to 240 s

6.7 Processing an external demand for hot water

The controller with electric actuator can process an external demand for hot water depend-
ing on the configuration. For this purpose, a measuring range (Xmin to Xmax) is assigned to
the current signal (0 to 20 mA or 4 to 20 mA, set point). The external hot water set point has
priority over the internal set point.

Note!
The controller can only use a Pt 1000 sensor to measure the DHW temperature when the
external demand for hot water is active.

Functions WE Configuration

F05 – Current input 0 F05 - 1

F06 – Current input function 0 F06 - 1

F07 – Measuring range of current input 0 F07 - 0: 0 to 20 mA
F07 - 1: 4 to 20 mA

Parameters WE Range of values

P03 – Lower measuring range value Xmin 0 °C 0 to   60 °C

P04 – Upper measuring range value Xmax 100 °C 95 to 150 °C

6.8 Binary output function

The binary output can be used either for pump control or as a fault alarm output.

Pump control (F13 - 0)
The controlled pump can be configured as a circulation pump in the DHW circuit or in the
heating circuit.
The pump is activated when the contact of the binary output is closed.
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Functions WE Configuration

F13 – Binary output function 0 F13 - 0

F14 – Pump control 0 F14 - 0: Circulation pump (DHW circuit)
F14 - 1: Circulation pump (heating circuit)

Circulation pump (DHW circuit): Binary output is active during hot water tapping and on
keeping DHW temperature in the heat exchanger con-
stant as well as when frost protection is active.

Circulation pump (heating circuit): Binary output is active when hot water is demanded for
the heating circuit (valve position > 0 %).

Fault alarm output (F13 - 1)
The contact of the binary output is closed when a fault occurs.

Function WE Configuration

F13 – Binary output function 0 F13 - 1

6.9 Direction of action

Specify the direction of action depending on the valve used.

Function WE Configuration

F04 – Direction of action 0 F04 - 0: Globe valve increasing/increasing
F04 - 1: Three-way mixing valve

increasing/decreasing

Globe valve (F04 - 0) and three-way diverting valve
� Actual value < Set point: Actuator stem retracts (globe valve opens)
� Actual value > Set point: Actuator stem extends (globe valve closes)

24 EB 5724 EN

Functions



Three-way mixing valve (F04 - 1)

� Actual value < Set point: Actuator stem extends (three-way mixing valve opens port
A -> AB and closes port B -> AB)

� Actual value > Set point: Actuator stem retracts (three-way mixing valve closes port
A -> AB and opens port B -> AB)

6.10 Manual setting

The function block F12 for a manually adjusted set point determines whether a Set point W1
adjusted at the set point potentiometer is to be used for control (see section 4.2). The follow-
ing then applies:

� F12 - 0: The W1 set point entered in TROVIS-VIEW applies regardless of the setting at
the set point potentiometer. The set point potentiometer setting is overridden.

� F12 - 1: (Set point potentiometer automatic) Setting at the set point potentiometer is
used for control if the setting is higher than 10 %. The internal W1 or W2 set
point entered in TROVIS-VIEW is used when the setting is below 10 %.

Function WE Configuration

F12 – Manually adjusted set point 1 F12 - 0: No manual setting
F12 - 1: Set point potentiometer automatic
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Fig. 9 · Type 3226 Three-way Valve mounted onto Type 5724/5752 Controller with Electric Actuator



7 Configuration and operation using TROVIS-VIEW interface

7.1 General

The TROVIS-VIEW software allows various smart SAMSON devices to be configured over a
common operator interface. It consists of the operator interface, communication server, and
the device-specific module. The software has a Windows Explorer look and feel.
The entire configuration of the controller with electric actuator can be performed over the
TROVIS-VIEW Configuration and Operator Interface.
The TROVIS-VIEW software containing online help and the database module for Type
5724/5725 Controller with Electric Actuator is delivered on a CD-ROM (order number
6661-1060).
Software updates are available in Internet (http://www.samson.de) in Services > Support
and downloads.

Note!
The following instructions include a description on the key functions of the TROVIS-VIEW
software in conjunction with controllers with electric actuators. Refer to the online help in the
? menu for a detailed description.

7.1.1 System requirements

Hardware requirements

� PC with Pentium II processor or equivalent (300 MHz or higher), 500 MHz recommended
� Serial interface or USB/RS-232 adapter
� Min. 96 MB RAM, 192 MB RAM recommended
� Min. 150 MB free hard disk space plus approx. 15 to 20 MB additional hard disk space

per SAMSON module
� SVGA graphic card (min. 800 x 600)
� CD-ROM drive

Software requirements

� Operating system: Windows® 2000 (min. SP2), Windows® 2000 XP, Windows® Vista
� Microsoft.NET Framework Version 2.0 (included on the installation CD-ROM)
� Internet browser: MS Internet Explorer, version 6.0 and higher
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7.2 Installing TROVIS-VIEW software

1. Insert the installation CD-ROM to start the installation program.
Once inserted, the CD-ROM usually starts the installation program automatically, de-
pending on the configuration of the operating system. If the program does not start auto-
matically, double-click setup.exe in the root directory of the CD-ROM in order to install
TROVIS-VIEW.

2. Follow the on-screen prompts and instructions of the installation program.

The TROVIS-VIEW Operator Interface can be used for several SAMSON devices. Note that
the installation program also offers you the option of installing a demo module. To use the
software without restrictions, the software needs to be activated as follows:

3. After installation, a dialog box will appear, prompting you to enter the CD key, which
you will find on the cover of the original CD-ROM.
Once you have entered the correct CD key, an activation is necessary. The software can
be activated automatically or manually. Internet access on the computer on which
TROVIS-VIEW is installed is required for automatic activation.

Manual activation:
Once you have entered the correct CD key, a request code will be automatically gener-
ated and displayed which contains computer identification details.
� Enter request code in SAMSON’s product activation server over the Internet.

(http://support.samson-ag.com/activate_eng.html)
An activation code is generated which allows TROVIS-VIEW to be used without any
restrictions in the purchased scope.

� Enter this activation code in TROVIS-VIEW.
The TROVIS-VIEW software is now ready for use.

Automatic activation:
A request code containing the computer identification details is transferred to the
SAMSON product activation server when an Internet connection is active and an activa-
tion code is automatically entered into TROVIS-VIEW.
The TROVIS-VIEW software is now ready for use.

Note!
Refer to the readme.txt file in the root directory of the CD-ROM for further information on in-
stallation, software updates and current system requirements.
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7.3 Starting TROVIS-VIEW and performing settings

You can perform the settings in TROVIS-VIEW either when the actuator is connected (online)
to the computer or without direct connection (offline) (refer to section 8).

Note!
When the device is not connected, the default settings appear on the operator interface or,
alternatively, a stored TROVIS-VIEW file (*.tro) can be loaded and overwritten by selecting
Open in File menu.

1. Start TROVIS-VIEW. The operator interface appears with menubar and toolbar as well as
various folders.

2. In Options menu, select Languages to
change the interface language.
Note!
The language can be changed
while the software is running.

3. Select Customer data in, Edit menu to
enter data relevant to the plant, e. g.
project name, plant location, operator.

4. Select Load Factory Defaults in Edit menu
(see sections 9.1 and 9.2) if you want to
load default settings onto the operator
interface.
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Properties of data points are indicated by icons on clicking on a folder:

Icon Meaning

Data cannot be changed

Data can be changed

Data point can be executed

Data point is user-defined

Mark to indicate error

Value has exceeded maximum limit

Value has fallen below minimum limit

Connection to the device is interrupted or there is a write protection error

Source of data:

Value has been modified manually

Value has been uploaded from the controller with electric actuator.
In online mode, X in the icon indicates a value has been updated.

Value originates from a stored file

Value has been adopted from memory pen

Value has been changed by the software
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7.3.1 Activating/deactivating functions

1. Click on Configuration folder to view the function block settings.

2. Double-click the function block status (0 or I) to change the status of the function.

Right-click on a row to open pop-up
window to modify configuration settings:

Modify To change the status of the function block.

Read Uploads status of the function block from device.

Write Downloads status of the function block to device.

Default: … Resets function block to default setting
(setting in gray to indicate that the status of the
function block is the same as the default setting)
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7.3.2 Setting parameters

1. Click on Parameter folder to view the parameter settings.
The parameters listed in the screenshot below are default settings.

2. Double-click the required parameter to
open pop-up window to modify
parameter settings.

Right-click the required parameter to
open pop-up window to modify
parameter settings:

Modify Opens pop-up window to
modify parameter
settings.

Read Uploads parameter value
from device.

Write Downloads parameter
value to device.

Default: ... Resets parameter to default setting (setting in gray to indicate that the
parameter value is the same as the default setting)

Min ... Set parameter to the displayed minimum value.
Max … Set parameter to the displayed maximum value.
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7.3.3 Reading operational information

Note!
Operational information can only be read when TROVIS-VIEW is directly connected to the
controller with electric actuator (i.e. in online mode, refer to section 8)

� Select Sensors folder to display actual data measured by the connected sensors.

� Select the Information subfolder in the Diagnostics folder to display information concern-
ing the actuator.
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� Select the Information subfolder in the Diagnostics folder to display information concern-
ing the actuator.
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8 Data transmission

The TROVIS-VIEW software installed on your computer allows you to configure the controller
with electric actuator either in offline mode (device not connected to a computer ) or in online
mode (device connected to a computer ). To activate online mode, click on the device
toolbar. The communication port must be set (see section 8.1)

Online mode (direct data transmission)
The actuator and TROVIS-VIEW are con-
nected constantly in online operation. Cur-
rent configuration and operating data are
uploaded from the actuator cyclically and
displayed in TROVIS-VIEW. The settings
configured in TROVIS-VIEW can be directly
transferred to the controller with electric ac-
tuator.
To enable communication with the com-
puter, connect the serial interface (COM
port) to the serial interface of the controller
with electric actuator using a SAMSON con-
necting cable.
In case the computer does not have a COM
port, a USB/RS-232 adapter can be used
when Windows 98, ME, 2000, or XP oper-
ating systems are installed on the computer.

Offline mode (indirect data transmission)
There is no constant data communication
between the computer and actuator. Com-
munication must first be established to up-
load from the actuator or download data to
the actuator.
Data can be transferred to the serial inter-
face over the SAMSON connecting cable or
over a memory pen together with a modular
adapter.
A memory pen allows you to simply copy
and download configuration data onto
other devices.
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Hardware package
order no. 1400-7704

Connecting cable

Memory pen
(also available separately:

order no. 1400-7697)

Modular adapter

USB/RS-232 adapter
order no. 8812-0016



Note!
You can only transfer data to the controller with electric actuator after the electrical connec-
tion has been completed as described in section 3.
Unfasten the front cover for data transmission.

8.1 Data transmission between TROVIS-VIEW and the actuator
(connecting cable)

1. Connect the serial port of the computer
using the SAMSON connecting cable to
the serial interface connection of the
actuator.

2. Select Communications in Options menu
to open the server settings window. Click
Server settings button.

3. Check Local connection and Auto-
matically local connect boxes and click
OK button to confirm server settings.

The Communication window reappears.

4. Click Port settings button.

5. The settings window opens and
State: not yet searched appears in the
Automatic detection field.
Click Start button.
TROVIS-VIEW has found the actuator
when State: Device found on ....
appears, click on OK button twice to
confirm settings.
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8.1.1 Offline operation (indirect data transmission)

In offline mode, there is no constant data communication between the computer and actua-
tor. Communication must first be established to upload from the actuator and download data
to the actuator.

Downloading data to the actuator:
Select Download to Device in Device menu to transfer data to the actuator. The actuator
starts to control after data are downloaded from TROVIS-VIEW.

Uploading data from the actuator:
Select Upload from Device in Device menu to transfer all the data from the actuator.
Uploaded data are indicated in TROVIS-VIEW by the icon.

Note!
Data transmission can also be performed by clicking the icons in the device toolbar:
click to download data from TROVIS-VIEW to the actuator and, click to upload data
from the actuator and to display them in TROVIS-VIEW.

8.1.2 Online operation (direct data transmission)

The actuator and TROVIS-VIEW are constantly connected in online operation. Current con-
figuration and operating data are uploaded from the actuator cyclically and displayed in
TROVIS-VIEW. Likewise, any settings performed in TROVIS-VIEW are directly transferred to
the actuator.
In the event of a sensor breakage, the interruption in sensor connection is shown without de-
lay in the Sensors folder.

Activate online operation:
Select Online in Device menu to activate online mode.
In online mode, in the device toolbar is animated.

Deactivate online operation:
Select Online in Device menu while the online mode is activated.
The online mode is canceled.

Note!
Alternatively, click in the device toolbar to activate and deactivate online operation.
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8.2 SAMSON memory pen

The SAMSON memory pen serves as a data carrier and is able to load and store data in its
non-volatile memory.

The memory pen can be loaded with data configured in TROVIS-VIEW and the settings
transferred to one or several controllers with electric actuators. In the same way, the memory
pen can be used to upload data from the actuator allowing you to simply copy the configu-
ration data from one actuator to another actuator of the same type.

Note!
On inserting a memory pen that is empty or that contains data from another type of device
into the serial interface port of the actuator, the data from the actuator are uploaded to the
memory pen regardless of the status of the memory pen and any other data on the memory
pen are overwritten.

8.2.1 Data transfer between TROVIS-VIEW and memory pen

1. Plug memory pen (3) together with modular adapter (2) into the serial interface (COM
port) of the computer (Fig. 11).
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2. Select Interface in the Memory Pen menu.

3. Click the Start button in Automatic detection field of the dialog box. The computer auto-
matically searches for the interface assigned to the memory pen.
Message: “Memory pen found at COM …“
Confirm interface setting by clicking OK button.

Downloading data from TROVIS-VIEW to the memory pen

4. Select Download to Memory pen in Memory pen menu

5. Click OK button to start data transmission.

Uploading data from memory pen to TROVIS-VIEW

4. Select Upload from Memory pen in Memory pen menu to start data transmission.

8.2.2 Data transfer between actuator and memory pen

� Perform steps 1 to 3 described in section 8.2.1.
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Uploading data from the actuator to
memory pen

4. Select Modify memory pen status in
Memory pen menu.
Check Automatically write to memory
pen in the dialog box.
Click OK button to confirm.

5. Remove memory pen from the computer
and plug it into the serial interface of the
actuator (Fig. 12).
Actuator data are uploaded onto the
memory pen.
The yellow LED underneath the serial in-
terface blinks twice several times to indi-
cate that data transmission is in prog-
ress.
Data transmission is completed when the
LED is illuminated continuously.
Remove the memory pen from the actuator.

Downloading data from the memory pen
to the actuator

4. Select Modify memory pen status in
Memory pen menu.
Check Automatically read from memory
pen in the dialog box.
Click OK button to confirm.

5. Remove memory pen from computer and
plug it into the serial interface of the
actuator (Fig. 12).
Data are downloaded from the memory
pen into the actuator.
The yellow LED underneath the serial
interface blinks several times to indicate
that data transmission is in progress.
Data transmission is completed when the
LED is illuminated continuously.
Remove the memory pen from the actuator.
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8.2.3 Copy function

The memory pen can be used to copy setting data to other Type 5724/5725 Actuators as
soon as the data from the actuator have been transferred to the memory pen (indicated by
the yellow LED blinking twice several times). Automatically write to memory pen is reset after
the first data transmission from the actuator.
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9 Appendix

9.1 Function block list

The function blocks F01 to F14 have the following listed functions.

F = Function block WE = Default setting 0 = OFF, 1 = ON

F Function WE Comment

01 Hot water tapping recogni-
tion

1 0 – Continuous control → Section 6.1
1 – Flow sensor active → Sections 6.1.1, 6.1.2

02 Flow sensor 1 0 – Flow switch → Section 6.1.1
1 – Flow rate sensor → Section 6.1.2

03 Adaptation 1 0 – Inactive
1 – Active → Section 6.1.2

04 Direction of action 0 0 – Globe valve increasing/increasing → Section 6.9
1 – 3-way mixing valve increasing/decreasing → Sec. 6.9

05 Current input 0 0 – Inactive → Sections 6.2, 6.3
1 – Active → Sections 6.1, 6.7

06 Current input function 0 0 – Actual value → Section 6.1
1 – Set point (processing for external demand)

→ Section 6.7

07 Measuring range of current
input

0 0 – 0 to 20 mA → Sections 6.1, 6.7
1 – 4 to 20 mA → Sections 6.1, 6.7

08 Binary input function 0 0 – Termination of function to keep temperature in heat
exchanger constant → Section 6.3

1 – Switching between internal set points → Section 6.2

09 DHW temperature in heat
exchanger constant

0 0 – Time adjustable → Section 6.3
1 – Continuous → Section 6.3

10 Upper limit GWH 0 0 – No limitation
1 – DHW exceeds GWH causes Y to be set to 0 %

→ Sec. 6.4

11 Lower limit GWL 0 0 – No frost protection
1 – DHW falls below GWL starts frost protection → Sec. 6.5

12 Manually adjusted set point 1 0 – No manual adjustment → Section 6.10
1 – Set point potentiometer automatic → Section 6.10
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F Function WE Comment

13 Binary output function 0 0 – Pump control → Section 6.8
1 – Fault alarm output → Section 6.8

14 Pump control 0 0 – Circulation pump (DHW circuit) → Section 6.8
1 – Circulation pump (heating circuit) → Section 6.8

9.2 Parameter list

The parameters have the setting ranges as listed below.

P = Parameter WE = Default setting

P Parameter WE Setting range

01 Set point W1 60 °C 0 to 100 °C

02 Set point W2 70 °C 0 to 100 °C

03 Lower measuring range value Xmin 0 °C 0 to   60 °C

04 Lower measuring range value Xmax 100 °C 95 to 150 °C

05 Upper limit GWH 95 °C 0 to 100 °C

06 Upper limit GWL 5 °C 0 to   20 °C

07 Proportional gain Kp 0.6 0.1 to  50

08 Reset time Tn 25 s 0 to 999 s

09 Derivative-action time Tv 0 s 0 to 999 s

10 Actuator transit time Ty 35 s 0 to 240 s

11 Set-back difference 8 K 0 to 30 K

12 Heating period for heat exchanger 24 h 0 to 48 h
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9.3 Customer settings

Station

Operator

SAMSON office responsible

Function blocks Parameters

F WE
Setting

performed P WE
Setting

performed Setting range

01 1 01 60 °C 0 to 100 °C

02 1 02 70 °C 0 to 100 °C

03 1 03 0 °C 0 to   60 °C

04 0 04 100 °C 95 to 150 °C

05 0 05 95 °C 0 to 100 °C

06 0 06 5 °C 0 to   20 °C

07 0 07 0.6 0.1 to  50

08 0 08 25 s 0 to 999 s

09 0 09 0 s 0 to 999 s

10 0 10 35 s 0 to 240 s

11 0 11 8 K 0 to   30 K

12 1 12 24 h 0 to   48 h

13 0

14 0
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